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Az el6z6 részben targyalt Scribus-
PDF ismeretek gyakorlatban torténd
alkalmazasaval folytatédik a sorozat.
Szamos eszkoz all rendelkezésre
a Scribus-ban arra, hogy a készitendd
PDF dokumentumunkat hasznos
megoldédsokkal tegyiik hatékonyab-
ba. A példaban két elektronikai alkat-
rész, mérési jegyzdkonyvének elké-
szitésére keriil sor, egy dokumen-
tumban. A jegyzékonyv rajzait
a Scribus-ban talalhaté Shape eszkoz-
zel készitjik el, igy megismerve an-
nak mikodését. A szerkesztés el6tt
azonban nézziik at a PDF Fieldre
(mezd) vonatkoz6 tulajdonsagokat,
beallitasokat. A PDF Fieldeket az
eszkoztaron taldljuk meg, egy
legordiils ikonlistaban. Az 1-6. Tibld-
zatokban a tulajdonsagok leirasait
foglaltam Ossze.

Type — A mezd tipusanak meghatdrozd-
sa. Annak elkészitése utan is lehetdsé-
glink van a tipus megvaltoztatasara.
Arra figyelni kell, hogy az egyes tipu-
sok eltérden engedélyezik a tovabbi
beallitasi lehet&ségek hasznélatat.

A Text Filed és a Combo Box mindent
megenged, mig a Button, Check Box
és a List Box csak az Appearance,
Options és Action tulajdonsagok
hasznalatat teszi lehet6vé.

Name — A PDF Field neve. Automati-
kusan felajanl egy sorszamozott nevet,
ami tetszés szerint moédosithat6.
Tool-Tip — A mezdhoz tartozo segédsiigo
szovegét irhatjuk ide.
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Kiadvanyszerkesztés Linux alatt - Scribus (. r¢s?)
PDF Field a gyakorlatban

Kint, a végtelen mezoén sétalva néha az az érzésem tamad, hogy minden

mas is kiszélesedhet. Kezdenek a hatarok eltlinni és mégis, a dolgok a maguk
keretei k6zott maradnak. Egyszerre 6sszemosddnak és élesen el is vallnak.
Ugyanugy hatborzongatoé érzés ez, mint ahogy csodalkozasra nyit6 is.

1. tdblazat Properties/Tulajdonsdgok tartalma

Type (Button, Text Field,
Check Box, Combo Box, List Box)

Name
Tool-Tip
Appearance
Options
Action
Format
Validate

Calculate

Border — A keret szélességét, szinét és
stilusdt adhatjuk meg. Ha nincs
sziikségiink keretre, akkor a szint és
a szélességet allitsuk None értékire.
A kiemelked? és a siillyesztett stilusok
térbeli megjelenést prébalnak kolcso-
nozni a mezdnek.

Other — A mez&be keriil§ tartalomra
(karakterlancra) érvényes a felsorolt
hérom tulajdonsag.

Visibility — Befolyasolhatjuk a mezé
lathatosagat, nyomtathatosagat.

Az ikonok kivalasztasa a megnyil6 fajl-
kezel6n keresztiil torténik. A hasznalha-
t6 képformatumok a tif, png, jpg, xpm,
valamint hasznalhat6 az eps Postscript
formatum is. Méretiikre vonatkozolag

PDF elem tipusa (Nyomdgomb, Szévegmezo,
Jelolédoboz, Kombinalt doboz, Lista doboz)

Az mez6 neve

Segédslgb

Megjelenés

A tipusra vonatkozé egyedi jellemzék
Esemény hatdsara bekoévetkezé muvelet
Karakterlanc forméatuma

Engedélyezés

Szamitasi muveletek

nincs megszoritas, e jellemzét az Icon
Placementben finomithatjuk.

Layout — Az ikon és a gombban latha-
t6 szoveg elhelyezkedését, egymashoz
val6 viszonyat rendezhetjiik.

Scale — A képet a gomb méretéhez iga-
zitja. A Never valasztasakor — a lenti
vizszintes és fliggsleges cstiszkdkkal -
a betoltott kép egy tertiletét jelolhet-
juk meg, ami a gombba fog keriilni.
Scale How — Az aranytartas nélkiili at-
méretezés teljesen kit6lti a gombot,
mig az ardnytarténdl el6fordulhatnak
iiresen maradt savok a széleken.

Multi-Line — Tobbsoros bevitelt tesz
lehetévé, hasznalhato benne a sorto-
rés (Enter). Ha tobb a szoveg, mint
ami a mezd&be latszolag belefér, akkor
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2. tblazat Appearance/Megjelenés tartalma

4. tdblazat Options/Egyedi jellemzdk

Text - Font for use with PDF 1.3

Border

Color

Width (None, Thin, Normal, Wide)

Style (Solid, Dashed,
Underline, Beveled, Inset)

Other
Read Only

Required

Don't Export Value
Visibility

Visible

Hidden

No Print

No View

Az elem altal hasznalt bet(tipus

Keret

Szin

Szélesség (Nincs, Keskeny, Normal, Széles)

Stilus (Egyszerl, Szaggatott, Alahlzott,
Kiemelkedd, Stllyesztett)

Egyéb, a kész PDF-re vonatkozé jellemzék

Csak olvashaté, a benne szereplé tartalom
nem modosithatd

A tartalom megadasa mindenképpen
szlkséges

Nem exportalhato a tartalom
Lathatosag

Lathato

Rejtett

Nem nyomtathaté

Nem lathato, de nyomtathato

3. tdblazat Options/Egyedi jellemzbk a Button/Nyomdégomb tipusra

Text

Text for Button Down
Text for Roll Over
Highlight

None

Invert

Outlined

Push

Icons

Normal

Pressed

Roll Over

Icon Placement
Layout

Scale (Always, Too small,
Too big, Never)

Scale How (Proportional,
Non Proportional)

Szoveg

A gomb lenyomasakor megjelenitendé széveg

A gomb folé vitt egérmutatéra megjelend széveg
A gomb lenyomasét kiséré effektus

Nincs effektus

Inverz megjelenés

Kérvonalazés

.Beslllyesztd"”, a Text for... szOvegeit ennél
a beallitasnal jeleniti meg

Ikonok hasznélata

Alapesetben |4thatd ikon

A lenyomaéskor megjelend ikon

A gomb folé vitt egérmutatéra megjelend ikon
|kon igazitasa

Elrendezés

Meéretezés (Mindig, Ha kicsi, Ha nagy, Soha)

Méretezés modja (Ardnyosan, Arénytartas nélkul)

a mezG oldalan megjelenik egy
gorditésav. Ezt letilthatjuk a Do Not

Scroll bejelolésével.
Password — A beirt karaktereket csilla-
gozassal helyettesiti.

A jelolés stilusat véalaszthatjuk ki, ami
hat kiilonb6z6 jel lehet (Check — Pipa,
Cross — Kereszt, Diamond — Gyémant,

a Text Field/Szévegmezd tipusra

Multi-Line Tobbsoros

Password Jelszébeviteli mezd

A beirhato karakterek
maximalis szama

Limit of
x Characters
Do Not Scroll

Do Not Spell
Check

Gorgetés tiltasa

Helyesiras ellenérzés
tiltésa

Circle — Kor, Star — Csillag, Square —
Négyzet). A kijelolést alapértelmezetté
is tehetjitk a Default is Checked bealli-
tasaval.

A dobozok szerkeszthet&ségét enge-
délyezhetjiik az Editable bejelolésével.
A két doboz kozotti egyik lényeges
kiilénbség, hogy a Combo Box a beirt
sorokat egy legordiil6 meniiben tarol-
ja, mig a List Box a sorokat a mezd
méretétdl fiiggden irja ki, ha kell gor-
dit6 sav segitségével. A masik eltérés,
hogy a List Box csak az Appearance,
Options és Action tulajdonsagok
hasznalatat engedélyezi.

A mez6hoz valamilyen esemény hata-
sara végrehajtando miveletet kapcsol-
hatunk. Az események hasznalatahoz
a JavaScript ismerete sziikséges.

A Type mentibdl kivalasztva egy tjabb
meni jelenik meg a valaszthato ese-
ményekkel (Mouse Down, Mouse Up,
Mouse Enter, Mouse Exit, On Focus,
On Blur). Az Edit ikon egy egyszerd
szkriptszerkesztét rejt, itt lehetSség
van kiils6, mar meglévd szkriptek
betoltésére is.

A Button tipusnal tovabbi események
is vélaszthatok:

Go To - A dokumentum (vagy egy
kiils6é PDF dokumentum) egy megha-
tarozott részére teszi at a nézetet.
Submit Form — A mezdk tartalmat
elkiildi a megadott URL cimre,

akdr HTML formatumban is.

Reset Form — Torli az 6sszes mezd
tartalmat.

Import Data — automatikusan egy kiilsé
f&jlbol (FDF — Forms Data Format) vett
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5. tablazat Forma&tumok
Plain Szabadon kitolthetd
Number Széam
Percentage Szazalékérték
Datum

|dé

Date
Time

Custom Szkripttel vezérelhetd

6. tablazat A Calculate

alapmdveletei
Sum Osszegzés
Product Szorzat
Atlagolas

Legkisebb

Average
Minimum

Maximum Legnagyobb

—Page Size

—Options

Size:

First Page Number:

Orientation:

| Portrait

Number of Pages:

Width:

E Height:
[] Left Page First

Facing Pages

Default Unit:

— [+] Automatic Text Frames

—Margin Guides
Top: E Inside:
E QOutside:

39.00 pt 40,00 pt

Bottom: 40.00 pt 40.00 pt

Columns: 1 E
1.ooopt B

W 7. 4bra Az (j dokumentum

adatokkal tolti ki a mezdket. Ilyen fajlt
a Reader Document->Forms->Export
Data From Form mentijével hozhatunk
létre, amit késGbb vissza is tolthetiink
a PDF féjlba a Document->Forms->
Import Data To Form meniiponttal.

A valaszthat6 formatumokkal (Field is
formatted as) a mezdbe keriil§ széveg
beirasat szabalyozhatjuk.

Plain — szabadon kitolthet6 mezét
hozunk létre.

Number — Csak szamot frhatunk be.
Tovabb fokozhatjuk a formatum kiala-
kitasat a Decimals — Tizedes rész és

a Use Currency Symbol — Fizetdeszkoz
Szimbolum tulajdonsagok megadasa-
val. A Prepend Currency Symbol

a szam elé helyezi a szimbélumot.

A szam, szazalékérték, datum és idé
megadasakor el6re beallitott sablonok-
bol vélaszthatunk. A szkripttel vezé-
relhet6nél JavaScript megirdsaval
,bonyolithatjuk” a mez§ kitoltését.

Az alapformatumokat a 5. Tdbldzatban
foglaltam Gssze.

A mezdbe kertil§ karakterlancot ellen-
Oriztethetjiik valamilyen elére megha-

/! Linuxvilag

Cancel

tarozott tartomanyon beliil, vagy
JavaScript segitségével.

Value is not validated — engedélyezés
nélkili hasznalat.

Value must be greater than or equal to —
az értéktartomany als6 hatara, ami
még lehetséges érték.

And less or equal to — az érték-
tartomany fels6 hatara, ami még
lehetséges érték.

Custom validate script — szabadon
megirt engedélyezési szkript.

A mezdbbe egy szamitdsi mivelet
eredménye kertil, amit az alapmtivele-
tekkel vagy JavaScript hasznélataval
kaphatunk meg.

Value is not calculated — szamitasi md-
velet nélkiili hasznalat.

Value is the ... of the following fileds —
A mez6 a felsorolasban résztvevd me-
z0k tartalman végrehajtott mdvelet
eredményét fogja tartalmazni. Itt

a tablazatkezel6kbdl ismert egysze-
riibb mtveleteket hasznalhatjuk,

6. Tdabldzat. A szamitasban hasznélatos
mezGket a Pick gomb mogott megbijo
ablakbdl valogathatjuk ki.

Custom calculation script — szabadon
megirt szamitdsi mdvelet.

Els6 1épésként hozzunk létre egy ha-
romoldalas Gj dokumentumot (File->
New) egyhasdbos tordelésre. A margo-
kat allithatjuk egységesre is, de célsze-
riibb a fels6t agy beallitani, hogy raes-
sen az alapvonalra. Az 1. dbra tartal-
mazza a dokumentum beallitasait.

A dokumentumban egységesen

a Nimbus Roman No9 L Regular
bettikészletet hasznalom.

Az elsé oldalra a jegyzSkonyv szovegét
helyezziik el, a masodikra egy tablaza-
tot készitiink a mérések eredményei-
vel, a harmadikra pedig az elkészitett
alkatrész(ek) rajzat. Az oldalszamozast
és az egyéb diszitd elemeket (amennyi-
ben ez utébbinak sziikségét érezziik)

a mesterdokumentum elkészitésével
(Edit->Master Pages), majd annak
alkalmazasaval illessziik be (Page->
Apply Master Page).

A befolyatott kenyérszovegbdl (2. dbra)
a formazast kévetden minden olyan
részt alakitsunk at PDF Text Fieldde,
ami jegyzékonyvenként valtozik.
Ilyen példaul a datum, a jegyzdkonyv
sorszama, a megrendelés szama,

a rendelt mennyiség, stb. Lesz egy
olyan sor is, ahol a PDF Combo Box-ot
fogjuk hasznalni, a teljes sor szovegé-
nek megvaltoztatasara.

A PDF Text Field kivélasztasa utan egy
négyszoget rajzolhatunk, ami a szo-
vegmezGt jelképezi, ez a mezs$ ugyan-
agy formazhat6, mint a szovegdoboz,
csak kiegészitették a fentebb emlitett
PDF funkcidkkal. A megrajzolt széveg-
mezGbe (érdemes valahol a dokumen-
tum fels6 részén elhelyezni) irjuk be

a sorszamot (az igy beirt sorszam az
Acrobat Readerben kitorolhetd/atirha-
td!) és kattintsunk kétszer a mezdre.

A felugré ablakban (3. dbra) a mezére
vonatkozo tulajdonsagokat allithatjuk
be. Az Appearance lapon vélasszuk

a Times bettikészletet, mert ez hasonld
a kenyérszovegnél hasznalt bettikész-
lethez. A mez6t kérbedlelS keret nem
sziikséges, ezért a Color és Width kap-
jon None értéket. A sorszam megaddsa
egy ilyen dokumentumnal fontos, igy
a Required kapcsolot aktivaljuk. Az
Options lapon korlatozzuk a befrhat6
karakterek szamat 11-re, tiltsuk le

a gorgetést és a helyesiras ellenérzést.
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W 3 4bra Field Properties/Mezd Tulajdonségok és a sorszam mez6

A Format lapon maradhat az alapértel-
mezett Plain formatum, amennyiben
alfanumerikus a sorszam felépitése (és
még egyéb karaktereket is tartalmaz).
Ugyanezzel az eljarassal atalakithatjuk
a dokumentumban talalhaté datumo-
kat, a rendelési szamot, a rendelt
mennyiséget, tipust.

A PDF Fieldnek van egy olyan tulaj-
donsaga, hogy az Acrobat Readerben
beirt szoveget a mezd kozepére helye-
zi (vertikdlisan). A tokéletes soregyen

beallitasa ezért lehetetlen, a nagy éke-
zetes maganhangzok azonnal ,letilte-
tik” a mez@ tartalmat. Amit tehetiink,
az annyi, hogy a mez6 kozéptengelyét
a kenyérszoveg bettiinek kozéptenge-
lyéhez igazitjuk. A 4. dbrin az Acrobat
Readerben megjelenitett dokumentum
lathat6, kiemelve a szovegmezdket
(kék) és a kotelezden kitoltendd
(Required) szovegmezdbket (vOros).

Ez a kiemelés a Reader sajatja, a doku-
mentum megnyitdsakor azonnal fel-
ajanlja ezt a lehet6séget (Highlight
fields és Highlight required fields)

darab vasmag
darab haz

25(
25(

legesen érkezett
darab vasmag

251
: 25(] darab haz
ifent maradt vasmagok [ darat

W 4 4bra Kiemelve és kitoltve
az Acrobat Readerben

A kenyérszovegben talalhaté egy
ilyen mondat ,Visszaszallitando
anyag nincs”. Ez lenne mindig

a legjobb, de néha keletkezik selejt
is, amit szintén fel kell tiintetni

a jegyzGkonyvben. Ezért ide behe-
lyeziink egy Combo Box-ot amit az
esetenként el6fordulé mondatok-
kal toltiink ki. Minden egyes monda-
tot egymas ala irva helyezziik el

a dobozban, célszerd a legtobbet
hasznaltat irni az elsG sorba (1. sor
Visszaszallitand6 anyag nincs. 2. sor
Visszaszallitand6 anyag van, vasmag
darab, haz darab.). Ezt kovetGen

a dobozt méretezziik at gy, hogy
csak egy sort foglaljon el. A Combo
Box ilyen fajta alkalmazasa esetén

a Preflight Verifier, Text overflow
(szoveg talfolyas) hibatizenetet
general, amit nyugodtan hagyjunk
figyelmen kiviil (Ignore Errors).

A Field Properties-ben engedélyez-
ziik a szerkeszthetGséget (Editable),
valamint a tobbi sziikséges tulajdon-
sagot allitsuk be.

© Kiskapu Kft. Minden jog fenntartva

Az ide keriil$ tdblazat a termék mérési
adatait fogja tartalmazni, minden cel-
lat érdemes ellatni a dokumentum
pontos kitoltését segité engedélyezési
(Validate) értékhatarokkal.

A tablazat cimsorat és a sorszamokat
tartalmazé oszlopot a Scribus tabla-
zatkészits eszkozével, a kitoltendd
cellakat pedig az Item->Multiple
Duplicate-tel sokszorositott PDF Text
Fielddel hozzuk létre. A tablazat mé-
rete: 7 (oszlop) x 31 (sor); az egyes
cellak szélessége akkora legyen, mint
a szovegtiikor hetede, magassaga pe-
dig akkora, hogy a kenyérszoveggel
azonos méretti karakterek elférjenek
benne kényelmesen. A cella tulajdon-

2006. jilius )
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Rétegelés

sagok megadasat masolas el6tt érde-
mes elvégezni. Az 5. dbrdn az elké-
szilt tablazat, a megnyitott ablakban
a Validate hangolasa lathato.
Amennyiben a tablazat elemeit
kalon-kalon csoportokba (Item->
Group) rendezziik és hagyjuk, az igy
elkészitett PDF f4jl, a kitoltéskor e
csoportokat figyelembe veszi. Erde-
mes kiprobélni egy és két oszlopos
csoportokra.

A harmadik oldal

Két alkatrészt abrazol6 rajzot helye-
ziink el az oldalra, négy kiilonall6 ré-
tegre (kettén fekete-fehérben, kettén
pedig szinesben). A réteget kezel6
eszkozt a Tools->Layers almeniiben
talaljuk meg. A 6. dbrdn a mar hozza-
adott négy réteget (T-1000 és T-2000,
valamint szines megfelel6ik) és az
alapréteget (Background) latjuk.

A felsorolas elején lathaté szem ikon
a réteg lathatésagat, a nyomtato ikon
a nyomtathatésagat kapcsolja ki-be.
A szerkeszteni kivant rétegre a sor-
szam vagy sor kijel6lésével léphe-
tank. Az als6 ikonsoron (balrél-
jobbra) haladva:

Add a new layer — Uj réteg 1étrehozé-

sa. Az 4j réteg mindig legfeliilre kertil.

16 Linuxvilag
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A kész dokumentum egyik rajza

Delete layer — A kivalasztott réteg
torlése.

Raise layer — Egy szinttel feljebb
helyezi a réteget.

Lower layer - Egy szinttel lejjebb
helyezi a réteget.

Els6ként a szovegmezdket készitsitk
el, majd rendezziik csoportba és ké-
szitstink masolatokat, amiket a rétegek
ugyanazon részére (példaul alulra)
helyezziink el.

A rajzok elkészitésénél a Shape
eszkoz beépitett alakzatait
hasznéljuk. Az ilyen egyszertibb
rajzokat, mint ez a toroid tekercs,
kiils6 rajzoléprogram nélkiil is
konnyen elkészithetjiik. Az alakza-
tok kozott taldlhato egy gytird,

ami mar j6 alapot nyajt a munkéhoz.
A tekercs drétozasat, a négyszog
alakzatbol készitettem el.

A Properties ablak Shape lapjan

a Round Corners értékét allitva

a négyszog sarkait a megfeleld
mértékire kerekithetjiik. A tobbi
mar csak egyszert masolgatas
(Item->Duplicate) és elforgatas
(Properties ablak, X,Y,Z lap,
Rotation). A tekercs kivezetéseit

a drétozas megnytjtasaval, a taka-
rasba kertilését az X,Y,Z lap Level
szintjének csokkentésével értem el.
Elkésziilt rajzunkat az utékor szama-
ra megdrizendd elmenthetjiitk

a Scrapbookba (Item->Send to
Scrapbook), igy onnan barmikor
el6vehetjiik Gjabb felhasznalasra.
A7. dbrin az egyik — kiszinezett —
toroid lathaté az Acrobat Readerben.
A kép baloldalan lathat6 a rétegek
listaja, amik koziil kivalaszthatjuk
az éppen aktudlisat a nyomtatashoz.

PDF irasa

Az eddigiek és az el6z6 részben leir-
tak utan ez mar nem okozhat gondot.
Az iras megkezdése el6tt a kotelezd
hibakeresés — esetiinkben — talal egy
hibat (Text overflow), ami szandéko-
san kertlt a dokumentumba. Nem
foglalkozva ezzel (Ignore Errors) ju-
tunk el a Save as PDF ablakra. Amire
fontos figyelni, hogy a rétegeket csak
a PDF 1.5-6s verzi6 tdimogatja. A réte-
gek tartalma bekertiil az ettdl eltérd
verzi6ji PDF fajlba is, csak nem lehet
valogatni kozottiik, ki-be kapcsolgat-
ni. Ezért, ha PDF 1.4-es fajlt készi-
tink, akkor csak egy réteg lathatdsa-
ga legyen bekapcsolva, killonben

az Osszeset egymasra pakolva késziti
el a PDF-et.

Nagyon sok lehet6ség rejlik egy

PDF fajlban, f6leg, ha valaki ért

a JavaScripthez is. {gy a hatérok ossze-
mosoédnak és a kiadvanyszerkeszto-
nek is lassan értenie kell a programo-
zashoz, szkriptirashoz.

A kovetkezd részben visszatériink

a Preferences menith6z és annak
bemutatdasahoz, valamint belené-
ziink a Story Editorba, ami

a nagyobb munkdk gyorsabb
szerkesztését segiti eld.




